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Qo ce cee 6 ee 6 a 6 eo eno eo eo ee ae 8ee
WhenI teach computerclasses, I alwaystell my students, “Don’t
be intimidated by the size of the manual andthe sense that you
have to memorize everything.” The trick to gaining an upper
hand with new software is knowing whatthings are called and
how to look them up.If the book has a good index, and you know
the terms, you canfind the information you need, when you need
it. Mosaic Quick Tour has a glossary of mostof the keywords you'll
encounter in Mosaic. Familiarize yourself with them, and looking
things up will be mucheasier.

So, dearfriend, grab a cup of coffee (catnip tea, or whatever you
drink), park yourself in your hydraulic ergonomicchair, fire up the ol’
PC andget ready to jack into hyperspace.

Into the future,

Gareth Branwyn
July 1994
gareth@vmedia.com

INTRODUCTION XVI
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The Curious Growth of Hypermedia
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bounds of CERN andthescientific community. Computer programmers
from around the world, excited by the possibilities of “hyperlinking”

documents throughoutthe Internet, began developing
Webapplications and promoting the World Wide Web
online. Early users also realized that not only hypertext,
but full-blown hypermedia, could be passed over the
Internet using Web technology.

It now looks as though hypermediais finally going to
make an impact, but in a way that its pioneers never
would have expected.

Mosaic: Free & Easy
Soonafter the introduction of the World Wide Web,soft-

ware designers at the National Center for Supercomputing
Applications (NCSA)at the University ofIllinois, Urbana-

Champaign, began work on a simple and powerful graphical interface
for WWW.With manysimilarities to HyperCard, Mosaic was designed
to be an easy-to-use, easy-to-build hypermedia system operated via
pop-up windows, pull-down menusand “point-and-click” navigation.
Excepthere, rather than weaving your way through the mediaavail-
able onasingle disk drive, you weave your waythroughthe vast
resources of the Internet! Mosaic’s first release in June 1993 (for X

Windows) was metwith great enthusiasm. Versions for Windowsand
Macsoonfollowed. Perhaps more than any other piece of WWW
software, Mosaic has helped fuel an explosionof interest in the World
Wide Web andthepossibilities of building a true “hypermedia uni-
verse” in cyberspace.

 

CHAPTER 1: THE Net & THE WeB 5
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Why NCSAs Mosaic So Great
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So your interest has been piqued and youre caught up on some Net

and Web history now its time to get busy The following chapter

covers all the basics on how to find Mosaic on the Net how to set it up

on your computer and how to take your first trip through the Web My

job will be to make all this sound easy Wish us both luck

10 MosAic QUICK TOUR
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journey of thousand miles begins ur trip is going to be short one so lets get down to business
with full tank of gas This tour guide is not for Net novices Im assuming youre already

Anonymous
familiar with Microsoft Windows modems basic telecommunications

and the Internet If you are unfamiliar with the Internet recommend

you read Michael Fraases Windows Internet Tour Guide Ventana Press
or some other introductory book See the bibliography for more

suggestions If you already have some form of File Transfer Protocol

FTP access such as dial-up account you can download electronic

versions of Brendan Kehoes Zen and the Art of the Internet from

ftp.cs.widener.edu or The Hitchhikers Guide to the Internet from

ftp.eff.org Search the EFF site for numerous other Net-related documents

In this chapter youll be given the information you need to find and

download Mosaic using conventional FTP on dial-up account You

can also download it using Windows-based programs such as Chame
leon FTP and Winsock FTP over SLIP/PPP connection details to

follow After youve wrangled Mosaic onto your hard drive and

unpacked it Ill show you how to do basic configuration of it so you
can jump into the Web immediately to have quick look around

Petitioner Microsoft Corporation, Ex. 1005, p. 11



Necessary Connections

If you are already on the Net and have Mosaic downloaded but still

need to install it skip this section and move on to Unpacking Your

Booty on page 20 To run Mosaic you need either direct or dedi

cated Internet connection found in many businesses government

offices and universities or you need whats called SLIP Serial Line

Internet Protocol or PPP Point-to-Point Protocol account Many local

Internet service providers now offer SLIP/PPP connections at very

reasonable rates In some cases the cost of the SLTP/PPP connection is

not lot more than standard dial-up account As these types of connec

tions become more common thanks in part to the growing popularity

of Mosaic service providers are making SLIP/PPP connections easier

to get and to set up Call your local provider for more information

01 TIP

For an updated electronic list of Internet service providers Peter

Kaminskis PDIAL list is highly recommended To get current copy

of the list send an email message to info-deli-server@netcom.com

with the message Send PDIAL If you do not yet have Net access

and therefore cannot get this list have wired friend download it

for you

There are two other pieces of software youll need to acquire and

install before you can get Mosaic up and running Lets take look at

them

The TCP/IP Protocol Stack

To make use of your SLIP/PPP connection once you have it youll

need to install TCP/IP protocol stack This is program that handles

the data transmissions between your PC and the rest of the Internet If

MosAic QUICK TOUR

Petitioner Microsoft Corporation, Ex. 1005, p. 12



youre using the Chameleon Sampler disk that came with The Windows
Internet Tour Guide or the Internet Membership Kit you already have all

the connection software you need its TCP/IP stack is called NEWT If

you dont already have TCP/IP connection software there are several

freeware/shareware packages you can download recommend the

shareware program Trumpet Winsock You can download it via FTP
from NCSAs FTP server located at ftp.ncsa.uiuc.edu in the directory

/PC/Mosaic/sockets or from ftp.utas.edu.au in the directory /pc/

trumpet/winsock Make sure you download both winsock.zip the

TCP/IP protocol stack and winapps.zip the Trumpet Winsock appli
cations See below for information on FTPing and unpacking trans

ferred files

Note If youre using TCP/IP stack other than NEWT or Trumpet

Winsock you may need to install small program called driver before

you can connect with the Net Consult the documentation that comes with

the TCP/IP stack to find out if youll need such driver Also dont be

afraid to consult with your Internet service provider or your network

administrator

Win32s for Windows

Once you have your TCP/IP software configured get the
necessary

configuration information from your Internet service provider youll
need to install special upgrade for Microsoft Windows 3.1 to be able

to run Mosaic 2.x If youre running under Windows NT you are

already in 32-bit mode and wont need Win32s From now on Ill assume

youre running Windows 3.1 From version 2.0A3 on Mosaic has been

32-bit application The Win32s upgrade is available by FTP from

ftp.ncsa.uiuc.edu in the /PC/Mosaic directory or directly from Microsoft

at ftp.microsoft.com The current version is called win32sll5.zip The

file will be transferred in the zip data compression format See below

for information on FTPing and unpacking transferred files

CHAPTER GErrING STARTED 13
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Note If you are running 32-bit application you already have Win32s

installed in your system Check to see if you have subdirectory called

Win32s under your Windows\System subdirectory If you do you will not

have to download and install it again

Important Note Win32s is not compatible with OS/2 If you have an OS/2

system youll need to use Mosaic Alpha the last version of the program

thats 16-bit Since Alpha Mosaic has been 32-bit

.1.101 TI

It is commonly held belief that SLIP/PPP connections are expen
sive and that the software is difficult to configure This may have

been the case but the recent increased interest among Internet

users for this type of connection has led to the widespread avail

ability of free or inexpensive TCP/IP software Several popular

book/software packages such as The Windows Internet Tour Guide

Ventana Press and the Internet Membersiup Kit Ventana Media

provide all the software you need Many Internet service provid

ers have developed helpful scripts and installation instructions

and will walk you through the connection procedure over the

phone if necessary Several providers will even configure the

software for you Call around and find provider that can give

you the level of assistance you need Dont be scared away from

this type of connectivity Its easier than you think

Downloading Mosaic

Once you have your Internet connection taken care of and Win32s

installed youre ready to download and install Mosaic

Note Obviously you dont have to download and install the TCP/IP

software Win 32s and Mosaic separately Since they are all available from

14 MOSAIC QUICK TOUR
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the NCSA site you can download them all at the same time using the

following procedure

Using Traditional FTP on Dial-up Account

If you have regular dial-up Internet account you can get all the files

you need for Mosaic by anonymous FTP Heres how

Create subdirectory on your hard drive called Mosaic or whatever

you care to call it

With your communications program log onto your user account as

you normally would

At the prompt type ftp ftp.ncsa.uiuc.edu

The double ftp is not mistake the first ftp is the command the

second is part of the address of the FTP site

Press Enter and you will soon be connected to the NCSA FTP server

At the login prompt type anonymous When asked for password
type in your full Internet email address username@site.domain This

is common network convention used with FTP logins hence the

frequently used term anonymous FTP

Note
If you hone trouble connecting to the NCSA site see the list of other

FTP mirror sites in Table 21

Once inside the FTP server youll want to change to the directory

that contains the Mosaic files That command is cd PC/Mosaic

Note Unlike DOSs backslash the Net uses UNiXs forward slash as the

subdirectori delimiter

From inside the Mosaic file area type is and press Enter Thats the

UNIX command for directory list Among the items listed you
should see wmos2Oa6rl .zip or whatever the latest version is called

CHAPTER GEvJNG STARTED 15
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The .zip extension on the end of the file name indicates that the file

has been compressed with PKWares ZIP utility and stored as binary

file Youll need to tell the host computer you want it downloaded as

binary file by typing bin It should respond with Type set to the

stands for image file or binary

To retrieve the program type get wmos2Oa6rl.zip or whatever the

file is currently called The file will then be transferred

10 If you havent already downloaded Win32s and Trumpet Winsock

if needed you can do so at this time Win32s is located in the same

directory under the name win32sll.zip Trumpet Winsock is located in

the next subdirectory in /PC/Mosaic/sockets

Note If youre on dial-up connection the file
will be

downloaded to your local host computer Consult the manual

provided with your dial-up Internet account and your

modem software manual if you are unfamiliarwith how to

get the file from their machine to yours

Using Windows-based FTP Program

If you have TCP/IP FTP software up and running such as

Chameleon FTP or WS-FTP you can use it to easily

download the programs you need See the instructions

that came with the software on how to configure it for

FTPing When youre ready to log on

Create subdirectory on your hard drive called Mosaic

or whatever you care to call it

Launch the FTP program and set the program for Binary

file transfer See Figure 2-1

I-ile Conned erver Settings lleIp

TranIer

ASCII

Binary

Change

Create

nemoveLjJ

Dir Inlo

Append LJ

Copy

InFo

Delete

Renamejj

Figure 2-1 typical FTP transfer window

16 MOSAIC QUICK TOUR
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Type ftp.ncsa.uiuc.edu in the appropriate box In Chameleon FTP
this is entered under the Connect menu item See Figure 2-2

Type anonymous in the User name box

For the password enter your full Internet email address

username@site.domain This is common network

convention used with FTP logins hence the frequently

used term anonymous FTP

Choose the OK button or whatever the command is to

establish the FTP connection

Once connected make your way through the directory

hierarchy to the PC/Mosaic directory

Once youve located the file wmos2Oa6rl.zip transfer it

to the Mosaic directory you created on your hard drive

following whatever instructions are appropriate for your
FTP softwarein the case of Chameleon FTP you would
select the left Copy button in the Files area of the FTP

window

Congratulations You now have Mosaic on your hard

drive If you havent already downloaded Win32s and

Trumpet Winsock if needed you can do so at this time

Win32s is located in the same directory The file name is

win32sll.zip Trumpet Winsock is located the next sub

directory in /PC/Mosaic/sockets

Connect

Host

User

Rpncsauiucedu

anonymous

Paword
IhIradnx_nxz.z1zI

yem Auto

Description

LJ

Ii_J Cancel

Figure 2-2 typical Connect dialog box

CHAPTER GETTING STARTED
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Due to the popularity of Mosaic the NCSA sites handle huge

amounts of traffic To ease this traffic jam try downloading Mosaic

from one of the additional FTP sites found in Table 2-1 below

Site Name Directory Path

ftp.vmedia.com /pub/companions/mosaicqt/mOSaic

sunsite.unc.edu pub/packages/infosystems/WWW/

clients/Mosaic/MosaicNCSA/

Windows

miriworld.its.unimelb.edu.au /pub/clients/PCmosaic

ftp.Iuth.se /pub/infosystems/www/ncsa/

Windows

ftp.sunet.se /pubpc/Mosaic

Table 2-1 Other FTP sites offering
Mosaic

Mosaic has been widely distributed throughout the Internet Besides

the FTP sites above many online services and other islands in the

Net have it in their software libraries Look around and download

using whatever method you are most comfortable with

18 MosAic QuicK TOUR
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The Ventana Visitors Center Ventana offers

an Online Companion for the Mosaic Quick

Tour as part of the Ventona Visitors Center

The Online Companion offers all the sofiware

mentioned in the Quick Tour with the latest

versions accessible as soon as they are made

available along with version change notes

There is also an online guide that will provide

you with quick access to Internet resources

related to this book The Mosaic Quick Tour

Online Companion will help make this book

dynamic up-to-date and continually useful

The Ventana Visitors Center can be found

at http//www.vmedia.com/vvc/index.htmf
The Mosaic Quick Tour Online Companion

can be found at http//www.vmedia.com/

vvc/onkomp/mosaicqtw/index.html

gopher.vmedia.com

ftp.vmedia.com

http//www.vmedia.com/vvc

info@vmedia.com

In body of message type send help

This will send more info about the

center not the Mosaic program itself

gopher.farces.com

ftp.farces.com

http//www.farces.com/

email almanac@farces.com

In body of message type send help

This will send more info about the

site not the Mosaic program itself

152 Computing Applications Bldg

605 East Springfield Ave

Champaign IL 61820-5518

Check America Online CompuServe or other services you may
have access to

The Ventana Visitors Center can be accessed as

follows

Gopher

FTP
www
email

Art and Farces

Gopher
FTP

www

Snail mailed from NCSA

The National Center for Supercomputing Applications creator and

maintainer of Mosaic has catalog of software offerings manuals and

other information You can get copy via email or snail mail

email orders@ncsa.uiuc.edu

snail mail NCSA Orders

CHAPTER GEIIING STARTED 19
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Unpacking Your Booty

Now that you have the necessary files transferred to your computer

youll need to unpack them The files come data compressed using

popular PC compression utility called PKZIP To unzip them youll

need PKUNZIP The latest versions of PKZIP and PKUNZIP come

bundled together as PKZ2O4G.EXE The 204G is the current version

newer versions will have higher numerical designations If you dont

already have PKZ2O4G you can get it via FTP from any of the sites

listed in Table 2-2

Site Name Directory Path

bits mit.edu /pub/dos/utilities/pkz2O4g.exe

epas utoronto.ca /pub/pc/util/pkz2O4g.exe

gatekeeper.3com .com /adapters/bin/pkz2O4g.exe

csuvaxl .murdoch.edu au /pub/pc/pkz2O4g.exe

Table 2-2 FTP sites offering
the PKZIP utilities

Put PKZ2O4G.EXE in its own directory and make that your current

directory It is self-extracting file so all you need to do is run it and it

unpacks itself After you have PKZIP/PKUNZIP installed on your

machine youre ready to unpack everything else and put it in its

proper place on your hard drive

Note its good idea to add the directory where PKUNZIP resides to your

AUTOEXEC.BATs pat/i statement That way you wont have to tell your

computer where the program is each time you wish to use it Youll only

need to type pkunzip -d and it will do the rest assuming the

zip file is already in the directory where you want the decompressed file to

live If you dont know how to modify the path in your AUTOEXEC.BAT

file shame on you and consult your DOS manual

20 MosAIc QUICK TOUR
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The basic procedure for unzipping files is simple

Make the directory where you want the files to reside your current

directory

Choose Run from the Windows File menu

Type pkunzip -d filename.ext such as wmos2Oa6rl.zip or

win32sll5.zip Your files will be unpacked

For further information on zipping and unzipping files see the

documentation that comes with PKZ2O4G You can also see documen

tation by typing pkunzip without any parameters at the File/Run

prompt

Unpacking Installing Win32s

When unpacking and installing Win32s

Make sure you install the zipped Win32s files in the following

subdirectory \windows\system\win32s Make this your current

directory

Choose Run from the Windows File menu

The Win32s files come zipped in two subdirectories \diskl and

\disk2 To make sure that the integrity of these directories is kept when

you unzip the files you need to use -d switch in your unpacking

command So the unzip command would look like this pkunzip -d

win32sll5.zip

Run the setup program in \diskl and you should be all set Read the

readme file

CHAPTER GETNG STARTED 21
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Unpacking & Installing Mosaic
When unpackingandinstalling Mosaic,

1. Start with the zipped Mosaicfiles in the Mosaic
subdirectory on yourhard drive.

2. From there, choose Run from the WindowsFile menu.

3. Type pkunzip wmos20a6r1.zip (or whatever the current
versionis called).

4. You should now have within that directory the follow-
ingfiles:

mosaic.exe The Mosaic programitself.

mosaic.ini Theinitialization and configura-
tion file. This should be copied
(not moved) to your Windows
directory.

install, update and Text files with the basic info and
readme.txtfiles latest update news on Mosaic.

faq.txt The latest copy of Mosaic Fre-
quently Asked Questions (with
answers, of course).

Onelast thing before we moveonto a basic configura-
tion of Mosaic. Mosaic requires that your system has
what's called a Winsock 1.1-compliant DLL (dynamiclink
library)installed. If you are using Chameleon or Trumpet
Winsock, you should beallset. If you’re using different
TCP/IP software or are on a local area network, check
with your network administrator and/or vendor to make
sure you havethe right Winsock DLLinstalled.
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Save As..

Allows you to save the current Mosaic document in different flavors

as plain text in HTML format or as binary file If you save docu

ment as plain text all HTML information will be stripped from it This

is similar to word processed documents formatted as ASCII text All

graphic elements type styles bold underline etc will be removed

Saving document as HTML writes it to your hard drive as an HTML
document with all link anchors links to other documents tags the

actual HTML codes URLs and other formatting information intact

This information is the source code of HTML

Save Preferences

Saves the currently configured screen dimensions and the current state

of items selected or deselected under the Options menu

Print..

Presents print options in standard Print dialog box Prints the full

contents of the current document including material above and/or

below the Mosaic document window If you want the printing to be

the same as what you see in Mosaic you must have scalable versions of

the fonts installed on your system Check font selections and change

as needed in the Choose Font section of the Options menu Print

button is also available on the toolbar

Print Preview

Displays copy of the document as it will be printed

Print Setup..

Presents standard Windows Print Setup dialog box

Note There is glitch in Mosaic Alpha Both the Preferences and Print Setup

quick key combinations use the key This will be fixed in the next version
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Document Source..

Opens an HTML version of the document you are currently viewing

Opening up and viewing HTML documents found on the World Wide
Web is great way to learn about how these documents are created

Document Source will only open up HTML and plain text

documents from your hard drive It will not open FTP
and Gopher directories

Choosing Document Source will take you to separate

window with its own menu The choices here are

File.. Save Saves the document that is displayed in

the Document Source window to your hard drive

The document must be saved with the .htm exten

sion This is the HTML extension translated for

DOS environment

File.. Exit Closes the Document Source window
and returns you to the main Mosaic window

Edit.. Copy If you click and drag selected text from

the Document Source window Copy will copy it to

the Clipboard for later pasting

You can also click on the OK button or press Enter

located at the bottom of the Document Source window to

return to the main Mosaic window

Note If you have problems getting the Document Source window to display

the current HTML document close the Document Source window Return

to the document you want to send to the Document Source window and

select Reload either from the toolbar or the Navigate menu After the

document has been redrawn return to the Document Source window and

you should now see the tagged HTML document

jark lolerne service Home Pagno

ALIGNlop ALT. SHC qraphico/claikomallgrr

-ClorkNel Home Page/HP

HHP

poh/clorkeellinleroelllClarkNet/A io loll lnlenel acc000 provider lot

many level ol oervice al very allordable HREF pob/clarkeelklarkoel

HHrP
HHEFhlo.l/ilhlml5LiqhlHoo.e PaqeoAc The Nellravele Slop lot good and oerviceo

HHP
HHEFhln.l/peoplohln.rThe ClarkNel People Pages/Ar Uoe Direclory Services

Figure 33 The Document Source window
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Exit

Now dont have to tell you what that does do

The Edit Menu
The Edit menu choices in Mosaic for Windows are short

and sweet Copy and Find. thats all you get

Copy

Copies selected text You can copy text from any of the

data entry boxes URL boxes and from the Document
Source window At this time you cannot copy material from Web
documents Hopefully the NCSA developers will implement this in the

future the Mac version already allows it For now you can use the

Save As command under the File menu to save text documents to disk

Copy button is also available on the toolbar

Find..

Locates text within the currently displayed document __________

window pops up asking Find What See Figure 3-5

check box within the Find window offers Match

Case search option This will match the upper- and lower

case of the text string being searched For example with

this option selected search on Table will not find

table Press the Find Next button to go to each occur

rence of the word or text string Find button is also

available on the toolbar

.1s

Find..

Figure 3-4 Mosaics Edit menu

Fifld Whet __ Lind ext

cance1

etch Case
lietp

ligurc 3s 17u \1oaii iiuI ellilva
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Is it box or is it window The difference between dialog box

and window can sometimes be confusing In Mosaic Quick Tour

the following distinctions are made

Windows are pop-up screens that can be moved around

opened or closed overlapped and placed behind and on top

of other windows Multiple windows can be open at the

same time

Dialog boxes cannot be moved and they will not go away until

you interact with them e.g entering information or pressing

button dialog-type box that is non-interactive doesnt
ask you to do anything is called Message box e.g
HTAccess Error Accessing

TIP

Make sure that when you quit your Mosaic sessions you discon

nect your Internet connection Just exiting Mosaic will not auto

matically discormect you This can be problem you can stay

connected for hours before noticing know from experience

Some services automatically break your connection if it remains

idle for certain amount of time Others dont Regardless the

best thing to do is to keep the connection window for your TCP/
IP software visible and remember to disconnect after leaving Mosaic

unless youre planning on using another TCP/IP application
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The Options Menu

The Options menu in Mosaic is one of the most useful

menus in the program It offers several monitoring func

tions for Web navigation Current URL and Status dis

plays and is used when displaying and moving
documents Load to Disk Display Inline Images Its also

where you access the Font windows which are important

for altering the look of your Web documents

Load to Disk

When checked tells Mosaic to load documents to disk as

you access them If youve selected this option whenever

you open new document either by clicking on link

anchor or by selecting Open URL Mosaic brings up Save

As dialog box instead of displaying the document You

select where you want the transferred file to be placed on

your hard drive This option is useful if you want to

retrieve say an MPEG movie and you want to keep it

rather than have Mosaic temporarily store it show it and

then dump it when you quit When youre done using

Load to Disk remember to turn it off in the Options menu

Otherwise the Save As dialog box will pop up every time

you select something Load to Disk button is also avail

able on the toolbar but is not yet implemented

38 MosAic QUICK TOUR

Naviqate Annotate St

/ShowToolbar

Show Status Bar

Show Current URL
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Use 8-hit sound

Choose Font.

ebugging info

Figure 3-6 The Optioiis menu
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You can also invoke the Load to Disk command using your

mouse Simply put the finger cursor over the link anchor of the

item you want to load hold down the Shift key and then click the

left mouse button The Save As dialog box appears After youve
saved the particular file to disk you do not have to de-select Load

to Disk from the menu Using the mouse approach only loads the

single file It does not turn on the Load to Disk feature

110T TIP

When saving files to disk remember to check their file names

keeping in mind that Windows is going to use only the first eight

characters before the extension and only the first three characters

of the extension for instance all html documents become .htm

documents In the Save As dialog box you can rename the file

something more sensible if the truncated eight-character name is

going to render it senseless

Show Toolbar

When this option is checked the toolbar is displayed along the top of

_________ the main Mosaic window just below the menu items See

JJ full explanation of the toolbar on page 74

Figure 3-7 The Mosaic toolbar
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Show Status Bar

Displays the area for status messages located in the bottom-left corner

of the main Mosaic window Status messages let you know

what Web document is currently being looked for when
connection is being made the status of the documents

transfer etc

Show Current URI

Turns the URL display box on and off in the main Mosaic

window When this is turned off the Status Indicator the
NCSA logo is also removed from the Mosaic window

When this item is selected moving the pointing finger cursor over

link anchor causes the Status bar to display the URL for that link

Change Cursor Over Anchors

Keep this option checked if you want the arrow cursor to switch to the

pointing finger cursor whenever hyperlinked item is encountered

Extended FTP Directory Parsing

Selecting this item will display cute little file icons whenever you arrive

at an FTP site When this option is not selected the FTP site will display

only drab and dreary file names and directories and who wants that

Display nline Images

Automatically loads inline images when you open document that
_____

contains them This dramatically slows down access time over dial-up

SLIP or PPP connection If Display Inline Images does not have check- ____
mark by it it is turned off and the inline image icons will he displayed htage
in the document window indicating that an inline image exists

Inline image icon

Show Anchor URIs

Oong dookup on no cern

Figure 3-8 The Status bar

URL hftp/Iwww vrnedia corn

Figure 3-9 The Document URL box and Status

lndicato
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Choose Font.. Normal

Debugging into
Header

Header

Header

Head er

Header

Header

Header

Menu

Directory

Address

Block Quote

exam pie

Preformatted

Listing

Figure 3-10 The Choose Font ubrnenu

To view inline images simply click on the icon using the right mouse
button The image will be transferred and displayed in the document

window If its hyperlinked inline icon indicated by border in the

anchor color you can

View the inline image first by clicking the right mouse button

Go directly to the hyperlinked item by clicking the left mouse button

the inline image will not be displayed

Show Group Annotations

In Mosaic for Windows 2.x you can share annotations over work

group To enable this feature this item must be checked See the section

on the Annotate menu below

Note You must also have the server name for your local area network

specfied in the mosaic.ini file to make use of group annotations

Use 8-bit Sound

With this checked all sound files that you transfer in

Mosaic will be handled by an 8-bit sound card This is

useful if you dont have 16-bit card installed

Choose Font..

Selecting this item presents you with submenu of style

types you can alter in Mosaics document view window See

the section on Using Styles in Mosaic later in this chapter

Debugging info

submenu offering series of alerts and warning mes

sages that can be toggled on and off when this item is

selected This menu is for developers only and is not for

average Mosaic use
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The Navigate Menu
Mosaic includes many menu command key and iconographic options

for navigating the Web The Navigate menu see Figure 3-11 offers

many of the same features found on the toolbar

Back

Lets you move back through the documents youve visited

most recently Back stays dimmed until you have previ

ous page to return to Back button is also available on

the toolbar

Forward

Lets you move forward through the pages youve visited

during your current Mosaic session Only works if you
have been back through pages and then decided to move
forward again Stays dimmed until you have forward

page to move to Forward button is also available on the

toolbar

Reload

Annotate St

Forward

Reload

Home

History

Add Current To Hotlist

Menu Editors.

Figure 3-11 The Navigate menu

Causes the current Web page to be redrawn in the document view

window Some sites also use the Reload command as way of loading

series of pictures Instead of going to several Web pages to view

succession of images you stay on one page and select Reload to see

new images Reload is also used when you make changes in or delete

an annotation and you want the changes to take effect immediately

Reload button is also available on the toolbar

Navigate _____________
Back
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Home

Takes you back to your home page which if youre using the defaulted

home page is the NCSA server Home can be comforting place to

return to if you get hopelessly tangled in Webspace Home button is

also available on the toolbar See Chapter for instructions

on building your own snazzy home pages

History

list of the documents you have visited during your
current Mosaic session is available here To return to site

previously visited and stored in History

Click on the History menu item window will appear

containing list of recently viewed documents See Figure

3-12

The currently selected Web document will be high

lighted Using the mouse select the site that you want to

return to and click the Load button You can also double-

click on the site name Either way Mosaic will begin its

attempt at accessing that site

When you are done viewing the History window
choose Dismiss If you load previous site the window

closes automatically after the document has loaded

Notice that the History window is scrollable field You can scroll up
and down to select other sites that may not be visible in the window

p//wwwccmuedu 8001 /Web
tp //www ncsa uiuc edu/G eneral
..-.i.-

ront000rhmI
lCSAHomehtmI

jcaLmisouri.edu/1 /reFerence/cenu/us/ba

Figure 3-12 The History window
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Add Current To Hotlist

Adds the currently displayed documents name and URL to your

currently selected hotlist To change the current hotlist

Choose Open URL from the File menu or from the

toolbar

Press on the arrow in the Current Hotlist box located in

the lower left-hand corner of the Open URL window

pull-down menu will appear showing all your hotlists

Select the list that you want to start using as your new

hotlist

Instead of clicking on OK which would load the first

document in the list choose Cancel The hotlist thats

visible in the Current Hotlist box when you cancel will

become the new list From now on when you choose Add

Current To Hotlist while at Web document that

documents name and URL will be added to the end of the

currently selected list

Menu Editor..

Allows you to build custom pull-down menus and

submenus This selection will take you to the Menu Editor

where you can delete add or change custom menus of

document titles/URLs See the Creating Custom Hotlist

Menus section later in this chapter for the lowdown on

this useful and flexible feature of Mosaic for Windows

Note All changes to the Menu Editor should be done here

not in the mosaic.ini file

lost in the Tangle of Hypertext History in

hypermedia is very important Studies done

early in the development of hypertext found

that people had hard time staying con
nected to their thought process if they got lost

in hypertangle of information Encouraging

self-exploration is great benefit of hypertext

hypermedia but that needs to be balanced

with sense of logical organization Being

able to see where youve been and to move

back to previous branching off points is very

important In Mosaic the History window and

the Back Forward and Home buttons help

you keep track of where youve been and the

documents youve browsed along the way

Mtn ft_

-Staiting Point

Woild Wido W.b Into

Hoi Pagan

Gotib Snion

Othn Ooannoto

QIJICKUST

Iop
dnWnbInIJ

Figure 3-13 The Menu Editor window
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The Annotate Menu

Lets you access written annotations personal Post-it notes that you
can attach to Web document

Opens an Annotate window see Figure 3-15 allowing

you to attach personal notes to the Web page currently

being viewed Your email address if you entered it in the

mosaic.ini file automatically appears in the Author box
To add an annotation

Select Annotate from the Annotate menu

In the Annotate window enter new name in the Author

box if you dont want to use your defaulted email address

Enter title for your note in the Title box

Type your note in the scrollable text box provided

When your note is complete click Commit

The annotation will not take effect until the next time

this page is loaded into the Mosaic document view win
dow If you want it to take effect immediately choose

Reload from the Navigate menu or from the toolbar The

words Personal Annotations will appear at the end of the

document indicating that this page has note attached to it

Note NCSA plans on adding an audio annotation to future

version of Mosaic

Annotate

Annotate

Startinq Points
Annotate

Edit this armotation

Dekte this annotation

Figure 3-14 The Annotate menu

Figure 3-15 The Annotate window
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To view an annotation

When you encounter Web page that includes annota

tions you will see the words Personal Annotations at the

very bottom of the page To view your notes choose
Do-It-Yourself Electronic Publishing The

Annotate from the Annotate menu
Internet is not only great place to engage in

When youre done reading the annotations choose
stimulating conversations and to consume

Dismiss from the Annotate window news and information it can also turn you

Other features of the Annotate window include into news and information producer Thou
sands of Net citizens publish their own elec

Clean Slate Deletes the current contents of the
tronic newsietters moaeratea maiiing lists

Annotate text field
FAQs and Web documents

Include File When implemented this feature allows Brock Meeks by day writer for

you to attach text file to your annotations This Communications Daily becomes one-man

does not work in Mosaic Alpha wire service by night He is the creator of

Delete Allows you to highlight and delete selected CyherWire Dispatch series of erratically

text from your annotations This is not working on published reports on significant Net happen-

Alpha For now if you want to delete text you
ings communications law and policy and

freedom of speech issues in cyberspace
have to msert the cursor and use the Backspace key

Meeks service is free and his dispatches are

Help Not yet implemented Will present onscreen serious in-depth and hard-hitting CyberWire
assistant in using the Annotate feature Dispatch has been mentioned in number of

magazines and dailies including The New
Edit this annotation York Times The Washington Post and Wired

Allows editing of text annotations This command brings magazine The Dispatch can be delivered

up the original annotation Once youve made your text directly to your email box by sending mail to

changes choose Reload from the Navigate menu or the majordomo@cyberwerks.com with subscribe

Reload button on the toolbar and the changes will take cwd-l as the first fine of your message To

effect immediately access CyberWire Dispatch on the Web send

URL to http//cyberwerks.com70/1

cyberwire Back issues are available in

gopherspace from gopher cyberwerks.com
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Delete this annotation

Allows you to delete annotations The deletion will not take effect

immediately The words Personal Annotation will con

Jon Lebkowsky and Paco Xander Nathan tinue to appear on the page until the next time Mosaic

both well-known Net personalities are quickly downloads this document If you want the deletion to take

becoming mini-media moguls Several years effect immediately select Reload from the Navigate menu

ago they started FringeWare company or the Reload button on the toolbar
and Net community dedicated to creating an

Note Annotations are personal and cannot be accessed

ternative marKetplace ror goo Ofl ser

vices offered by Net citizens They now anyone else on the Internet They are stored on your hard

maintain conference on the WELL BBS
drive and are not made part of the HTML documents you are

publish Net-based catalog moderate
vIewing Mosaic for Windows does allow you to share

mailing list on alternative community and do-
tations over workgroup Unfortunately you can only have

it-yourself technology and publish two print
group or personal annotations in documents not both

magazines FruigeWare Review and
Starting Points

Unsnavea Trutns Anair tnat wasn

enoughthey have day jobs The FringeWare
This menu is your gateway to some of the most useful

Home Page is located at http//io.com/
resources on the Internet From here you can easily access

commercial/fringeware/home.html
the various Web pages at NCSA other university sites

These are just Iwo examples of successful Net- Gopherspace the Finger and Whois gateways and an

based publishing efforts There are countless Archie server If you have read this Quick Tour and are

others As you delve deeper into the Web youll ready to do some serious Web walking this is an excellent

find many new and exciting forms of media place to start The following table lists the items available

under the Starting Points menu and what they offer
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Menu Item Offering

Starting Points hyperlinked reference page containing numerous key Internet re

sources Contains most of the resources listed below and lot more

NCSA Mosaic Demo Document Provides an interactive tour of Mosaics capabilities

NCSA Whats New Page Opens NCSAs frequently updated list of news and new offerings on the

Web

NCSA Mosaic Home Page Connects you to the home page of the Web server at NCSA

Windows Mosaic Home Page The official entry point and information center for the Microsoft Win
dows version of Mosaic

World Wide Web Info Includes subdirectory of information on the WWW and series of

searchable Web directories great place to get an broad overview of

Web offerings

Home Pages Instant links to the front doors of 21 university Web sites

Gopher Servers Gateways to eight Gopher information servers including the popular

Veronica and the original Gopher at UMN Also includes comprehen

sive directory of all the Gophers in the world

Finger Gateway Provides URL connection to the Finger Gateway at the University of

Indiana Finger is UNIX-based utility
that can be used to search email

and biographical information about people on UNIX networks

Whois Gateway Whois allows you to search for people in cyberspace

Other Documents brief listing
of other interesting Net points This hotlist is also good

place to add your own hotlist items until you learn how to create your

own

Archie Request Form form-based Archie gateway for the WWW Lets you access series of

Archie servers throughout the world

Table 31 Startin Points on the World Wide Web
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AO Page

ug List

ftature Page

About Windows Mosaic..

Mail to Developers..

Figure 3-16 The Help menu

Note The Starting Points menu is completely user-configurable You can

add/change/edit however you like See the section below on Creating

Custom Hotlist Menus for more information Also keep in mind that

Mosaic isfreeware and is passed through the Net by many hands The

version you download may have different items added or subtracted from

the above list This just means that an individual loaded
copy to Net site

that they had already customized If the additions/changes are acceptable no

problem If you suspect that your copy of Mosaic has been monkeyed with

in disagreeable way try getting new copy from different site

The Help Menu
The contents of the Help menu are only accessable if you are Net

connected These files are not stored on your machine they are located

at NCSA See Figure 3-16

Online Documentation

Contains an online users guide prepared by the developers at NCSA

FAQ Page

Takes you to series of Frequently Asked Questions about

Mosaic for Windows

Bug List

An up-to-date listing of the known bugs and bug-like

features in the current version of Mosaic

Feature Page

history of the features of the various versions of Mosaic

for Windows
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About Windows Mosaic..

standard About. program identification box listing version

number copyright information developers names and the email

address at NCSA

Mail to Developers..

Allows you to send an email message to the software

developers at NCSA When chosen window pops up
with the email address of NCSA hardwired in If youve
entered your email address in the mosaic.ini file all you
have to do is enter the subject of your message in the

Subject box and the text of your message in the scrolling

text box When youre done click Send and your pithy

prose will be posted to NCSA
Two important things to remember

Before you can send this email message you must enter

your return email address on the E-mail line in the

mosaic.ini file If you havent done that you can still use

this option by manually entering the address of your email

account in the appropriate box as username@site.domain

Since Mosaic does not support other forms of email besides this

outgoing message to the developers you need to have regular

Internet address to receive an answer

As you might imagine the developers at NCSA get lot of mail from

Mosaic users Please dont take advantage of this service Before you
send your questions make sure youve looked through Mosaic Quick

Tour in the online Mosaic help documents and at the various Mosaic

and WWW FAQs Frequently Asked Questions files

Figure 3-17 The Mail to Developers window
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Note Its shame that the NCSA address cannot be changed in this win
dow If it could then this feature could be used as an outgoing mail box to

anyone on the Net If youd like to be able to send and receive email during

your Mosaic sessions you can use programs such as Eudora See Chapter

for more information

Configuring Preferences

You enter your preferences here for how you want Mosaic to behave in

the mosaic.ini file You should have already copied not moved the

mosaic.ini file from your Mosaic directory to the Windows directory

When editing this mosaic.ini file its probably good idea not to be

running Mosaic OK ..call me superstitious

To open the mosaic.ini file use the Windows Notepad or any text

editor or word processing program You will see that the mosaic.ini file

is divided into series of subsections Lets run through them section

by section and examine what they contain

______
This section contains identification information for your
email address and your Home Page There are also

number of display options See Figure 3-18

E-mail address here

By adding your email address between the quotation

marks you are telling Mosaic where you want it to return

any email messages that you send to the developers at

NCSA using the Mail to Developers option in the Help

menu This address will also be defaulted as the Au
thor of your personal annotations Enter your address in

_______ the standard form of username@site.domain

Figure 3-18 The section of the mosaic.inifile

Re dit eurCn Snip

Enailuser@nite .donain

Hone ragesttp fonna.ncsa.uiuc.eau/SDG/Snftnare/ninnosaiC/HonePage stnl

Help Page.flttp //noJnu.ncsauiuc.odl/SDI/SCRtoaro/Hlnnosaic/O0C5/04000nOC.stnl

FAQ Pagrhttp//wnn.nesa.uiuc edo/SPi/SnFtnare/HinMnSaic/FHQ.htDs

Bug listbttp I/o.ns.ncsa.uilc .edu/SDC/Snftnore/OIjnHosaic/OuQS fltni

Feature Pagehttp//noo.ncsa.uiuc.ndu/SDG/SnFtnare/Wintosaic/Featuros .btnl

Display inline inagesno
Donp nnflory 55oCBOQeR
ireynacigroondno

Fancy Rulesye5
Round List Bullntsyes
Current HntiistO5 Hotlists

Show OAiS5eS
Enteuded FnNyns
Toolbaryes
Status barges
TitieIUIW saryes

ARdour CelnrHiO55

nldth7in

heightH83
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Autoload Home Page

Setting this to yes will cause the Home Page URL listed below to be

loaded whenever you launch Mosaic If you dont want page loaded

automatically set this to no

Home Page here

This is the Web-based or local drive-based HTML document that you
want Mosaic to access each time you open the program If you dont

want Mosaic to load any home page you still need to set Autoload

Home Page to no Just deleting the URL here would not be enough
The Home Page URL is usually defaulted to the server at NCSA

If you decide to use an HTML document on your hard drive as the

default Home Page youll need to use the following URL form

file 7//c directory/filepathname

The Help Page FAQ Page Bug List and Feature Page are all

URLs that are accessed by Mosaic for use in the Help menu Do not

change these unless one of the URLs becomes obsolete

Display Inline Images
If this item is set to yes each time you access Web document that

contains graphics Mosaic will automatically load the graphics after

loading the text For slower connections SLIP/PPP it is recom
mended that you have this set to no This way you can save the time of

waiting for all the mimes to load After the page is loaded you can then

decide which images you want to view To load them click on the

inline image icon with the right mouse button

Dump memory blocks

This is something that was added to Alpha and will not appear in

future versions Ignore it

52 MoSAIc QUICK TOUR

Petitioner Microsoft Corporation, Ex. 1005, p. 52



Why Do You Think They Call It Mosaic
At this point youve probably realized that

Mosaic for Windows is pretty cool program

But you may also be wondering where its

name came from Why is World Wide Web

browser named alter type of art that com
bines different pieces of material such as

glass or tile to create complex designs

Wellthats exactly what Mosaic does Rather

than having to reinvent the wheel every time

new multimedia format is introduced it

assembles Web hypermedia using external

programs that are all put together in Mosaic

Because Mosaic uses this open plug-in

approach it can remain flexible as new

media forms enter cyberspace New anima

tion formats QuickTime VR for example
No problem Just define new MIME type

map it to the appropriate viewer application

and Mosaic is ready to display QuickTime yR

New sound format Just configure the sound

program point Mosaic to it in the mosaic.ini

file and off you go Mcsaic takes all these

pieces and puts them together into multi

mediawellmosaic

If set to yes fancier type of rule will appear in HTML
documents tagged with an in HyperText Markup

Language

Round List Bullets

Allows you to replace round bullets in bulleted lists with

little flat line markers This saves load time if this option is

set to no

Current Hotlist name here

Entering the name of hotlist here will make that list the

current list each time you return to Mosaic You can make

other lists the Current Hotlist during your Mosaic ses

sions but each time you return the list entered above will

be defaulted

Anchor Underine

Link anchors or hyperlinks are shown in color in

Windows Mosaic defaulted to blue If you also want all

links to be underlined set this item to yes

Note Its good idea to use Anchor Underlining if youre

using Mosaic with monochrome or grayscale monitor

Otherwise link anchors will not be obvious to you until you

drag the cursor over them assuming you have Anchor

Cursor set to yes

Grey Background

If set to yes the NCSA document view window will have grey back

ground the same shade of grey as the panel above the document

window If set to no the document view window will be white

Fancy Rules
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